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The W&T EnOcean Com-Server enables linking of EnOcean RF
sensors and actuators with visualization software and control
systems over a TCP/IP Ethernet.

The EnOcean Com-Server passes the signal from the RF
components to the software via Intra- or Internet, which
generally communicates with the Com-Server via OPC. A single
EnOcean Com-Server allows you to control up to 128 RF
actuator groups, with an unlimited number of receiving RF
sensors.

Important: In spite of various measures intended to
increase transmission reliability, including repeated
sending of wireleless telegrams at random intervals,
the fact that EnOcean components do not have an
intrinsic acknowledgement function means that loss of
a sent telegram cannot be completely precluded. In
critical applications it is thus necessary to generate
acknowledgements for successful transmission of a
telegram from the process itself, such as by monitoring
the wireless generated actions.

The converter has a 10/100 MBit Ethernet connection and a
narrow DIN rail housing for ease of integration in building
installations and control cabinets. Configuration of the device
involves setting just a few network-specific parameters and is
accomplished using a convenient software tool provided.

The EnOcean network interface is described on the following
pages, including its technical data, configuration and wiring
examples.

Up-to-date information about new products and current
firmware and software can be found on the Internet at
http://www.wut.de or in the e-mail notices from the W&T
Interface Club, which you can subscribe to from the
W&T homepage.
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W&T Assigning the IP address

Subject to errors and modifications

Initial startup of the EnOcean Com-Server

Initial startup of the EnOcean Com-Server generally involves
simply setting the IP address, the subnet mask and specifying
any gateway which might be present.

These settings can be conveniently made using the WuTility
management tool, which provides all the necessary configura-
tion options and which can be found on the included product
CD-ROM.

Additional assigning of a password for protecting the EnOcean
Com-Server settings from unintended or unauthorized change
can be done from the browser if Web-Based-Management on the
converter is activated or from the Wutility using telnet.

Serial communication of the network interface using the
integrated EnOcean RF module is set by default to a fixed
format and should under no circumstances be altered, since
this would prevent correct function of the converter.

Assigning the IP address

The EnOcean Com-Server is factory set to IP address 0.0.0.0.
Before assigning a new one you must obtain an appropriate IP
address from your system administrator. In smaller, unrouted
networks use the IP address of your PC and simply change the
last digit. Always note however that IP addresses must be
unique within the network.

, IP assignment using the WuTility management tool

, Setting the IP address, subnet mask and gateway address
using DHCP-/BOOTP protocol

i
Every IP address must be
unique within the network.
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Assigning the IP address using WuTility

The Windows tool WuTility allows you to inventorize
Com-Server and Web-IO installations and to assign the
IP address. The prerequisite is that the current address of the
EnOcean Com-Server is 0.0.0.0 (= factory default setting) and
that the computer containing WuTility be located in the same
subnet.

Downloading and installing WuTility
The most current version is always available from our Web site
under the following address:

http://www.wut.de

From there use the menu tree on the left side of the screen.
The path

Products & Downloads r Com-Server r Tools

will take you directly to the page with the download link.

Die Installation erfolgt über einen Doppelklick auf die Datei
wutility_***.msi. Der Start von WuTility erfolgt über

Start r Programme r W&T Software Toolkit r WuTility

IP assignment
Be sure that both the EnOcean Com-Server and the computer
are connected to the network and are located in the same
subnet. Some Windows versions also require that you are
logged on to the PC as Administrator.

You can identify the desired EnOcean Com-Server based on its
MAC address from the device list generated when starting
WuTility. The displayed IP address must be 0.0.0.0.
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Subject to errors and modifications

Select the EnOcean Com-Server and then click on the button

In the following window enter the values for the desired IP
address, subnet mask and any gateway which might be present
and confirm your entries by pressing Continue.

In addition, in the next window you can activate BootP (see fol-
lowing section) and configuration of the EnOcean Com-Server
via Web Based Management (see section Configuration via
browser - Web Based Management).

i
Every IP address must be
unique within the network.
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After confirming your entries with Continue the network para-
meters of the EnOcean Com-Server are correspondingly
changed and the values entered in the device list:

This concludes assigning of the minimally required parameters.
We recommend however that access to the EnOcean Com-
Server configuration be password protected. This prevents
applications accessing the interface accidentally changing the
serial configuration of the device and thus affecting proper
function.
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Subject to errors and modifications

IP assignment using DHCP-/BOOTP protocol

Many networks use DHCP (Dynamic Host Configuration Proto-
col) or BOOTP for centralized and dynamic assigning of IP
addresses. Which of the two protocols is used in a given case
does not matter to the EnOcean Com-Servers, since DHCP
represents simply a downward compatible expansion of BOOTP.
DHCP servers also make use of requests from BOOTP clients.
The following parameters can be assigned to the EnOcean
Com-Server using these protocols:

• IP address
• Subnet mask
• Gateway address

It is not possible to send any other parameters or a lease time.

Function description
To obtain an IP address the EnOcean Com-Server sends a
corresponding BOOTP request as a broadcast to the network
after each new start. The reply then generated by the DHCP/
BOOTP server contains the IP address as well as the subnet
mask and gateway address. The EnOcean Com-Server immedia-
tely stores this information in its non-volatile memory.

To start up the EnOcean Com-Server in DHCP/BOOTP networks,
contact your system administrator. If you are using DHCP to
assign the address, please note that a reserved IP address is
needed. To add it to the respective address database, the
administrator will need the Ethernet address of the EnOcean
Com-Server, which can be found on the part label on the
housing:
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After the administrator has made the necessary entries, the
EnOcean Com-Server automatically obtains the desired
IP address after each reset. To ensure availability of the
EnOcean Com-Server even should the DHCP/BOOTP server be
down, the previous IP address is retained when no reply is
forthcoming.

1 In DHCP environments the IP address to be assigned
must be reserved by means of a fixed link to the Ethernet

address of the EnOcean Com-Server. Under Windows NT this is
done in the DHCP manager under the menu item „Reser-
vations“.

Deactivating DHCP/BOOTP/RARP
A DHCP server assigns IP addresses dynamically from an
address pool specified by the administrator. This means that
DHCP-capable devices usually get a different IP address after
every start. Since a constantly changing IP address is not
desired in connection the the EnOcean Com-Server, the latter
uses BOOTP protocol, which is based on fixed associations of
Ethernet to IP address. DHCP servers should only reply to
BOOTP requests if they have an explicit IP reservation for the
Ethernet address of the sender.

Some DHCP servers (e.g., Windows 2000 servers) however use
both DHCP and BOOTP requests from your dynamic address
pool. To prevent the EnOcean Com-Server from assigning
unknown IP addresses to the user in such environments, the
following options are available:

• Make a reservation in the respective DHCP server before
connecting the EnOcean Com-Server to the network.

• In existing systems the BOOTP client of the EnOcean Com-
Server can also be activated and deactivated at any time using
the telnet configuration under
SETUP System r SETUP TCP/IP r BOOTP Client.



1 1

W&T Connections, operating elements and displays

Subject to errors and modifications

Connections, operating elements and displays

Form factor
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Ethernet connection
The EnOcean Com-Server has an IEEE 802.3 compatible network
connection on a shielded RJ45 connector. The pin configu-
ration corresponds to an MDI interface, so that the connection
to the hub or switch is made with a 1:1 wired and shielded
patch cable.

1 = Tx+

2 = Tx-
3 = Rx+

4 = nc 5 = nc
6 = Rx-

7 = nc

8 = nc

RJ45 female (AT&T256 standard)
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10/100BaseT, autosensing
The EnOcean Com-Server supports both 10BaseT and
100BaseTx with a bit rate of 100 Mbps and the possibility of
full-duplex transmission. Switching between the two network
speeds is automatically set by the autosensing function of the
converter depending on the capabilities of the hub or switch
used. The prerequisite for 100 Mbps is suitable cabling (at least
Cat. 5/ISO Class D).

Galvanic isolation
The network connection is galvanically isolated from the supp-
ly voltage with an isolation voltage of 500V

rms
.

Link status
The Error LED on the front panel of the device indicates the link
status: when it flashes at 1-2 second intervals, the connection
to the hub is either not present or is in a fault condition.

Antenna connection

The antenna of the EnOcean Com-Server is configured as an
external λ/4 radiator so that the antenna can be installed
for proper reception regardless of how the EnOcean Com-
Server is installed. The antenna has a magnetic base to make
installation easier.

The HF connection of the EnOcean Com-Server is implemented
as an SMA socket to which the included external antenna is
connected. Please use only the antenna included in the scope
of delivery, since only this combination will ensure adherence
to the emissions limits.

Although it is possible to extend the length of the antenna ca-
ble ini theory, this will adversely affect the radiated HF power
and the receiving sensitivity of the overall system.

1
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Supply voltage

The supply voltage of the EnOcean Com-Server is brought in at
the screw terminal located on the bottom of the housing.
DC voltage of any polarity or AC voltage may be used.
Following are the maximum and minimum values for the
supply voltage:

• AC: 9Veff (-10%) .. 30Veff (+10%)
• DC: 12V (-10%) .. 48V (+10%)

If the plug-in power supply included in the scope of delivery is
used, the plug pins can be connected to the screw terminals.
The current draw is typically 70 mA at a voltage of 24 V DC.
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LED indicators

• Power-LED
Indicates presence of supply voltage. If the LED is not on,
check the power supply connections.

• Status-LED
The Status LED of the EnOcean Com-Server flashes
whenever there is network activity on the RF interface.
Periodic flashing indicates that the port has a valid
connection to another network station. The status of the
serial port can also be read out over the telnet configuration
menu of the EnOcean Com-Server.

• Error-LED
The Error LED of the EnOcean Com-Server indicates fault
conditions using various flash codes. The error texts for the
last five occuring serial faults and the associated system
time (time between the last restart of the EnOcean Com-
Server and when the fault occured) can be read out using
the telnet configuration tool.

1 x flashing = Check network connection
The EnOcean Com-Server cannot receive a link pulse from a
hub. Check the cable or the hub port.

2 x flashing = Check serial data format
At least one character with a parity/framing error was
received at the internal serial port, or the data register of
the serial receiver chip was written to but the previous
character had not yet been read out.
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Subject to errors and modifications

Please note that the serial format must always be
set to 9600 baud, 8 bits, no parity, no handshake.
All other settings wil result in malfunction of
the EnOcean Com-Server, since the integrated RF
module only works with these parameters.

Power-, Status- and Error-LED on = self-test error
The self-test performed by the EnOcean Com-Server each
time it is started or reset could not be correctly finished.
This error can occur if you have prematurely aborted a
software update and could not send the complete operating
software. The EnOcean Com-Server is no longer operative in
this state. Repeat the software update over the network (see
section Firmware update) and address the EnOcean
Com-Server with its assigned IP address.
If this does not remedy the fault or should it occur for
reasons other than an incomplete software update, please
return the device for inspection.

• RF Out - LED
Indicates sending of EnOcean RF telegrams. The LED
flashes briefly each time a data telegram is sent.
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Subject to errors and modifications

Configuration access to the EnOcean Com-Server

After finishing hardware installation and assigning the
IP address, the remaining configuration of the EnOcean
Com-Server is done over the network. Here either a telnet client
or, after corresponding activation, an Internet browser can be
used.

Structure of the configuration menu

Regardless of whether a telnet client or Internet browser is used
for configuration, the setup of the EnOcean Com-Server is tree
structured. The following illustration shows an overview of all
levels with their respective parameters.

A valid IP address must have already been assigned to the
EnOcean Com-Server before configuring (see section Assigning
the IP address). Access is then possible from virtually any
computer having network access and an installed TCP/IP
protocol.

A description of both configuration accesses, their dependen-
cies as well as the respective navigation within the menu tree is
contained in the following sections

HTTP protocol and its standard port 80 are frequent targets
of Web attacks. So as not to affect data throughput of
the applications and the EnOcean Com-Server, Web Based
Management is therefore deactivated by default. Ways of
activating it as part of initial startup can be found in the
section on Web Based Management.
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Configuration menue tree:

INFO System

SETUP System

SETUP Port 0
SETUP Port 1
SETUP Port 2
SETUP Port 3

SAVE Setup

Cable Type
MAC address
SOFTW Date/REV
HARDW Rev
Run Time

Setup TCP/IP
Telnet Password
System Password
System Name
Flash Update
Factory Defaults
Reset

IP-Address
Subnet Mask
Gateway
MTU (512-1024)
BOOTP Client

Keep Alive Time
Retransmisssion
Timeouts

Standard Gateway
Route 1
Route 2
Route 3
Route 4

Destination
Netmask
Gateway

Net Update
Serial Update (Port 0)

TCP Client

UDP Client

Serial Socket
Interface

Telnet Client

FTP Client

Box to Box
(TCP)

IP Bus Mode

SLIP Router

System Options

Server Port
Server IP
Special Options

Port State

UART Setup

TCP/IP Mode

Connection State
Error State
Clear Port Mode

Baud

Parity

Data Bits

Stopbit

Handshake

FIFO S/R:

Standard Baudrates
Special Baud Divisor

230,4k
172,8k
115,2k
57600
38400
19200
9600

4800

2400
1200
600
300
150
110
757200
50

NONE
EVEN
ODD

8
7

None
Hardware
Software
Special

1
2 Pin: RTS

Pin: DTR
Pin: CTS
Pin: DSR
XON/XOFF
XON/XOFF (Filter)

FIFOs OFF
FIFOs ON

disable
8/8
16/16
32/56
56/60

Local Port TCP/UDP Inactivity Timeout
Connect. Timeout
Disconnect Char
Dispatch String 1
Dispatch String 2
Client: "C"+Addr
Response Mode

Server Port
Server IP
Special Options

Serial Coding
Serial Protocol

Dispatch String 1
Dispatch String 2

Client: "C"+Addr

Disconnect Char
Write: "C"+Addr

Serial Protocol
Serial Coding
Protocol Char

Server Port (23)
Server IP
Special Options

Disconnect Char
Inactivity Timeout
Serial 0d -> 0d00

Server Port (21)
Server IP
Special Options

Auto FTP
FTP Client Login
Inactivity Timeout
Connect. Timeout
Protocol Char

Server Port (21)
Server IP
Special Options

Server Port (21)
Server IP
Special Options Dispatch String 1

Dispatch String 2Slave: Master IP
Master: Subnet IP

Net Address
SLIP-Net Routing

Network Delay
Flush Buffer
Telnet Echo

(Highspeed
Serial)

Logout

WBM Port

Telnet:
Transfer the selected parameters and save all settings
in non-volatile memory on the Com-Server

To activate the new settings
always save using SAVE Setup

with Telnet or the LOGOUT

link on the webpages

Browser:
Transfer the selected parameters and save all settings
in non-volatile memory on the Com-Server
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Configuring via telnet

A telnet client is included standard with nearly all operating
systems which support TCP/IP protocol. Under Windows this is
usually found in the Windows root directory. The configuration
menu for the EnOcean Com-Server can be reached through TCP
port 1111. You must therefore start the connection from within
the telnet client using the corresponding parameters:

Telnet [IP address] 1111

[adress] = IP address of the Com-Server
1111 = Configuration port of the Com-Server

Under Windows 9x/NT you only need to invoke Start r Run
telnet. Then in the submenu Network system... of the Connect
enter as the host name the IP address of the EnOcean Com-
Server and then port number "1111".

If the connection was opened successfully and no system
password is assigned (= factory default), you will see the follo-
wing menu in your telnet window. If a system password was
configured you will be prompted for it before the menu.
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The items INFO System, SETUP System and SAVE Setup as well
as their submenus are described in the following section
Basic configuration of the EnOcean Com-Server. The descrip-
tion of the individual menu branches and the respective
parameters is described in the following sections.

Navigation within the telnet menu
The overview of the entire configuration menu of the EnOcean
Com-Server is shown on the previous page. You will see only
one level of the selected menu on the monitor. Simply entering
the number of the desired menu branch and pressing the
ENTER key will take you to the next level. Entering q or pressing
the ENTER key takes you back to the last menu level.

The last configured value of a menu item appears in paran-
theses. When you make changes the new value appears at this
point the next time the menu is opened. It only becomes
effective in the EnOcean Com-Server however if you have saved
it using SAVE Setup.

As long as you do not open this menu item, you can move
around in the entire menu and change values without any
changes taking effect.

Configuring via browser - Web Based Management

The EnOcean Com-Server can also be configured using HTTP
protocol and a standard Internet browser. The menu structure
of WBM (Web Based Management) is compatible with the telnet
configuration.

For reasons of security and downward compatibility, Web Based
Management is deactivated by default.

i
If you exit the
configuration menu
by closing the Telnet
connection without
first doing a SAVE
Setup, the original
configuration will be
retained.



2 1

W&T Configuration access to the EnOcean Com-Server

Subject to errors and modifications

Activating WBM with the WuTility-Tool
WBM can also be activated as part of the initial IP assignment
using the WuTility inventory and management tool. Activate the
option Enable Web Based Management in the corresponding
program window and enter the desired TCP port (Standard port
= 80).

Activating WBM with the WuTility tool
To activate WBM on an already running EnOcean Com-Server,
you can use a telnet configuration. Start a telnet session on
Port 1111 of the EnOcean Com-Server. In the menu branch

2. SETUP System r 1. Setup TCP/IP r 6. WBM Port

enter the decimal number of the desired TCP port under which
you want WBM to be reached. Then press the Return key until
you are back in the main menu and there open SAVE Setup.
After you have closed the telnet session you can now access
the EnOcean Com-Server from an Internet browser.

Starting the navigating the WBM
To access the Web sites after activating the WBM, start your
Internet browser and in the address line enter the IP address of
the EnOcean Com-Server and the configured port number:

http://[IP address]:[port number]
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If the HTTP standard port 80 was configured for WBM, you can
skip entering the port number in the address line.

You are now at the start page of the EnOcean Com-Server with
a prompt for the system password. The factory default setting
is for no password, so actuating the Login button takes you to
the configuration menu.

Navigation
Since the WBM of the EnOcean Com-Server is session oriented,
you msut use the Back links and corresponding control
buttons to navigate to the individual Web pages. Use of the
back functions in the browser can lead to problems in trans-
fering the set parameters.

During a configuration session you can make as many settings
as desired. Clicking on the Send button on the individual
pages causes the EnOcean Com-Server to temporarily buffer
store them. Once all the settings have been done, always exit
the configuration session using the link Logout  and the Save
button.
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Subject to errors and modifications

Only this way are the settings you made stored in the non-
volatile memory of the EnOcean Com-Server and then activated.

The logout page then offers the following options for ending
the configuration session:

n

Clicking on the Save button transfers all changes made to
the non-volatile memory of the EnOcean Com-Server and
ends the configuration session.

n

Clicking on the Abort button causes the EnOcean Com-
Server to cancel all the settings made and ends the confi-
guration session.
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n

Clicking on the Restore Defaults button resets the EnOcean
Com-Server to its factory setting. All settings including the
network parameters IP address, subnet mask and gateway
address are lost.

n

Clicking on the Firmware Update button activates the
mode in which the .EnOcean Com-Server expects a firmware
update using TFTP protocol (see section Firmware update
for the EnOcean Com-Server). Update mode can only be quit
by complete transmission of a valid firmware or by interrup-
ting power. If the WuTility tool is used for the firmware
update, this mode is automatically started. A manual start
is not necessary in this case.

n

Clicking on the Hardware Reset button resets the EnOcean
Com-Server, similar to interrupting the supply voltage. Data
from any other open connections to the EnOcean Com-
Server will be lost in this case.

The functions located on the logout page of the EnOcean
Com-Server can be found also in the telnet menu branch SETUP
System r  Setup TCP/IP.
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Basic configuration of the EnOcean Com-Server

This section is devoted to an explanation of the relevant
configuration options which pertain to the operating system of
the EnOcean Com-Server and which are not directly related to
the serial port. The arrangement and function of the individual
parameters within the menu structure are for the most part
identical to configuring via telnet and the Internet browser.

Alll menu tree entries not described are not relevant to
operation of the EnOcean Com-Server and should not be
changed from their settings as delivered. Changes to these
functions can result in malfunction of the device, which in
extreme cases will require resetting to the factory settings.



2 6

W&T Basic configuration of the EnOcean Com-Server

Saving the settings

Whether configuring via telnet or using Web Based Manage-
ment, all changes are first temporarily saved in the EnOcean
Com-Server. To have the settings available after a reset or
power interruption, each configuration session must be ended
with explicit saving.

Telnet
Select SAVE Setup in the master menu. To the prompt Save
Changes? enter y. If the entry was correct, Saving... appears on
the monitor and the EnOcean Com-Server saves all the settings
you made in its non-volatile memory. Once the data have been
stored, they are automatically activated each time you power-
up or reset the EnOcean Com-Server.

If you enter anything other than y or simply press the Enter key,
you are returned to the main menu without saving the values.

1Exceptions are the network parameters, IP address,
subnet mask and gateway, since these are also relevant

for the running configuration session. To save and activate
them the telnet configuration must be quit using q after
choosing SAVE Setup . The EnOcean Com-Server then
automatically performs a reset and only then works using the
new settings.

Browser - WBM
Exit the configuration session using the link Logout and click
on the Save button.
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Menu: INFO System

This menu allows you to obtain the device-specific parameters
such as version number and create date of the firmware, MAC
address of the device, etc.

n Cable Type
Indicates the speed, whether the connection to the hub or
switch is running with 10BaseT or 100BaseTx.

n MAC address
Indicates the Ethernet address of the EnOcean Com-Server.
This number is factory set and registered. It cannot be
changed.

n SOFTW Date/Rev.
Indicates the create date and version number of the opera-
ting software in flash.

n HARDW Rev.
Indicates the revision status of the EnOcean Com-Server
hardware.

n Run Time
Indicates the time in hours and minutes since the last re-
start of the EnOcean Com-Server.
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Menu: SETUP System

This menu is where all parameters affecting the operating
system of the EnOcean Com-Server and which are independent
of the serial port are configured

Menu: SETUP System r Setup TCP/IP

n IP address (Default= 0.0.0.0)
Enter here the IP address if you want to change it. Please
note that this number is not freely selectable, but rather
should be specified depending on the network address of
the TCP/IP network. The entry form corresponds to the
usual syntax (e.g. 172.16.231.5).

n Subnet Mask (Default = 255.0.0.0)
The subnet mask only needs to be entered if the EnOcean
Com-Server will be opening connections to another subnet-
work. Enter the subnet mask of the subnetwork in which the
EnOcean Com-Server is located (e.g. 255.255.255.0).

n Gateways (Default = 0.0.0.0)
In this menu tree you can configure the IP address of the
standard gateway or routers. If not fixed routes are con-
figured, the standard gateway for all network packets whose
destination IP address is not in the local subnetwork are
used.

n Route 1 - 4 (Destination, Netmask, Gateway)
In addition to the standard gateway up to four fixed routes
can be defined. Packets whose destination IP addresses are
located in the networks configured here (=Destination) are
always delvered over ths gateway associated with this
route. A fixed route is only accepted by the EnOcean Com-
Server if the following check is true:

Destination AND Netmask == Destination

If the result is not the same as Destination, the entries are
rejected.
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1 Changes to the system parameters IP address,
Subnet Mask, Gateway and Route 1-4 cannot be activated

immediately after saving. Only after closing the current telnet
connection with q does the EnOcean Com-Server work with
these values.

n MTU – Maximum Transfer Unit (Default: 512)
This value determines the maximum size of a TCP/IP packet.
It refers to the number of bytes (excluding header) which
can be sent in a packet. The smaller the MTU selected, the
more network buffers are available overall in the EnOcean
Com-Server. The selectable range begins at 512 and ends
at 1024 bytes. The values can be set in increments of 128
bytes (automatic rounding).

n BOOTP Client (Default: 1 = ON)
The factory setting is for DHCP-/BOOTP protocol activated
(menu entry = 1) and the EnOcean Com-Server attempts
after every reset to get an IP address from a DHCP or BOOTP
server. Entering „0“ deactivates the function (see section
Assigning the IP address using DHCP-/BOOTP protocol).

1Some DHCP servers also assign an IP address -
    upon a BOOTP request from their dynamic pool. To

prevent the EnOcean Com-Server from getting a different IP
address after every reset in such environments, BOOTP
protocol must be deactivated.

n WBM Port (Default: 0000)
The value specifies in decimal form the TCP port under
which the Web Based Management (WBM) of the EnOcean
Com-Server can be reached from an Internet browser. The
factory setting is 0000, which means that WBM is deactiva-
ted. If for example the value 80 (= standard port HTTP) is
set, Web configuration can be invoked from an Internet
browser without having to explicitly specify the port
number.
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It is sufficient to specify the IP address or the name of the
EnOcean Com-Server stored in the DNS. When using other
port numbers these must be separated in the address line
of the browser by a colon (e.g. http://172.17.231.49:1234).

n Keep Alive Time (sec) (Default: 0 = OFF)
If the keep alive check is activated by entering and saving a
value in second ticks, all TCP connections are monitored
for network-side data traffic. If there is no network traffic
within the set time, the EnOcean Com-Server generates a
keep alive packet. If the other party dies not answer this
packet, the connection in the EnOcean Com-Server is reset.
Any data present in the serial in- and output buffers are
deleted.

Example: A TCP client has opened a connection to the TCP
server port 8000 on the EnOcean Com-Server and the
network connection is then interrupted. After the set keep
alive time, plus 2s for two repetitions, the EnOcean Com-
Server closes the connection and is then available for any
other clients.

n Retransmission Timeouts (ms) (Default: 240)
This timeout specifies how much time elapses before
network packets are repeated if necessary. In most networks
the default setting of 240 ms can be used. Only in the case
of very large latency times between the EnOcean Com-
Server and its respective communications partner may this
value need to be increased.

Menu: SETUP System r Telnet Password
At this point you can specify an 8-character, hexadecimal
(character range = 0 ...9 + a ...f) password for protecting the
configuration menu from unauthorized access. The factory
setting is 00000000. This allows unrestricted access to the
configuration menu of the EnOcean Com-Server.
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A valid password is immediately asked for after opening the
telnet connection to the configuration port. If the entry is
incorrect, access to the configuration port of the EnOcean
Com-Server is denied.

1Resetting or changing any parameters including the
password itself is only possible by knowing the old

password. For this reason you should write it down and keep it
in a secure place.

Menu: SETUP System r System Password
The system password consisting of any 31 characters protects
all configuration and control accesses to the EnOcean Com-
Server as follows:

· 1111: Telnet configuration menu
· [WBM-Port]: Web Based Management (if activated)
· 8003: Reading the configuration file
· 8004: Writing to the configuration file
· 8888: Resetting the EnOcean Com-Server
· 9084, 9184, 9284, 9384: Reset Port Status A-D
· 9094, 9194, 9294, 9394: Control port A-D
· 161 (UDP, SNMP)

On telnet port 1111 as well as the WBM port the system pass-
word is asked for directly after opening the connection. For all
other listed TCP ports the password must be sent to the
EnOcean Com-Server no later than 2s after opening the TCP
connection.

Requests from SNMP managers are only replied to by the
EnOcean Com-Server if the Community corresponds to the
system password.

1The system password has a higher level than the telnet
password. This means after assigning a system

password any previously set telnet password becomes invalid,
and the system password must be used for all password entries.
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Menu: SETUP System r System Name
The freely configurable system name consisting of maximum
31 characters is used for identifying the EnOcean Com-Server.
It is displayed as the start message in the client for all telnet
connections.

Menu: SETUP System r Flash Update
Before you activate one of the two following modes, be sure
that any active network connections have been closed first.
Then confirm with y. Update mode is indicated by illumination
of the Status LED of the EnOcean Com-Server.

n Net Update (TFTP)
Activate this mode if you want to perform an update of the
operating software of the EnOcean Com-Server over the
network using TFTP (see section Firmware update of the
EnOcean Com-Server).

n Serial Update (Port 0)
This update mode is not available for the EnOcean Com-
Server.

1You may exit update mode only after the update has
been completely finished or by performing areset, i.e.,

interrupting the power

Menu: SETUP System r Factory Defaults
Enter a y to restore the EnOcean Com-Server to its factory
default settings. The configuration will then correspond to the
defaults stored in the EnOcean Com-Server. The EnOcean
Com-Server closes the telnet connection. It then performs a
software reset to activate the new configuration.

1Resetting the non-volatile memory results in the loss of
all settings different from the default values, including

the IP address. The setting profile of the factory defaults may
under some circumstances be replaced by a custom profile. In
this case the custom settings are activated after resetting.
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Menu: SETUP System r Reset

Select this menu item to perform a software reset on the
EnOcean Com-Server. First the telnet connection is properly
closed.

1All data from any still opened network connections
are lost!
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Data communication

Communication between the visualization software or host
system and the EnOcean Com-Server is generally handled over
the standard software interface OPC.

Direct access to the data of the integrated EnOcean RF module
is of course also possible by exchanging the information
between application and EnOcean Com-Server through the W&T
COM Port Redirector. In this case the data in- and output of the
EnOcean RF module appears as a virtual PC COM port through
which the application itself has to process the EnOcean
protocol.

The EnOcean Com-Server also makes it possible to handle the
data transfer with the EnOcean components using TCP/IP or
UDP/IP protocol. Information on using this communications
procedure is available on request.

An inexpensive visualization and automation software
package for smaller applications is the „Showit“ program
developed and marketed by

Ingenieurbüro BAUER
Güntherstraße 6
D-14612 Falkensee
Tel.: +49 (0) 3322 / 21 21 103
Fax: +49 (0) 3322 / 21 79 75
E-Mail: info@showit.de
www.showit.de

A free demo version of the program is available on the
Internet. This is a full version which is available for a
limited period of use for testing purposes.
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OPC-Server

The W&T OPC server is the communications interface for the
EnOcean Com-Server running under Windows-based systems
which allows use of standard software applications for control
and visualization. Many visualization programs, such as
Show-It, Wonderware or LabView are able to use this software
interface as an OPC client. This allows the integrator to
concentrate fully on programming the application without
having to deal with the deals of the EnOcean protocol.

Installing the OPC server

The W&T OPC-Server for network I/O devices is contained on
the W&T product CD included with every EnOcean Com-Server.
You will find the software under menu item EnOcean > OPC-
Server. Clicking on the Install button the associated installa-
tion program guides you through the steps for setting up the
OPC server on your PC.

Since the OPC server is regularly enahnced with function
additions, W&T makes the current version of the software
availalbe on the Internet at www.WuT.de. The link to the OPC
server is found under Tools on the data sheet page of the
EnOcean Com-Server.

You do not have to deinstall the previous version to update to
a new version of the OPC server.

Setting up the OPC server

Access to an EnOcean Com-Server and its associated RF
sensors and actuators through the OPC interface requires that
you first set up the EnOcean Com-Server within the OPC server.
In a second step you assign the Com-Server in the OPC server
its EnOcean components.
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Setting up the EnOcean Com-Server

Under Device > New Radio transceiver a configuration window
opens where you can enter the parameters for a new EnOcean
Com-Server:

Hostname or IP address:
In this field you enter the IP address which was assigned to the
EnOcean Com-Server at installation. Alternately you can use a
name instead of the IP address, if a host name was assigned
the address via DNS or a similar name service.

TCP port number:
8000 is the default value for the TCP port number. This value
can be changed and desired and must be adjusted correspon-
ding to the setting for the Com-Server. We recommend however
leaving this value unchanged.

Base ID:
In this field you enter - if known - the base ID of the EnOcean
transceiver module built into the Com-Server. The ID is required
for sending RF telegrams over the EnOcean Com-Server, since
the integrated transceiver module has to be accessed for
sending with its own ID. If this value is not known, you can
obtain it from the Com-Server by clicking on the Retrieve
button.
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System password:
If a password was set in the Com-Server, that access code must
be entered in this field. Required entry of a password protects
the configuration of the EnOcean Com-Server from being
changed without authorization. Caution: If the password is lost
or forgotten, there is no way of accessing the Com-Server
settings. In this case the Com-Server will have be reset to the
factory default values.

Status update every:
A regular status query simply checks whether the device is still
accessible. The time interval of these queries can be set in this
field.

OPC device name:
The name you select here is used only for linking the EnOcean
Com-Server with the sensors and actuators associated with it.
The name is not part of the OPC variable name. The OPC device
name can be automatically generated or assigned. In the
former case the name has the format Trcv[n] where
n= 1..65536.

Allocation of sensors and actuators

In a second step the sensors to which the Com-Server is
supposed to respond are allocated to the EnOcean Com-Server.
If needed, signals of virtual modules can also be created by
means of which the EnOcean Com-Server can control RF
actuators which it has learned.

In the window of the OPC server select the EnOcean
Com-Server to which you want to allocate the components. The
menu item Device > New Radio module takes you to the
following entry screen in which the linked EnOcean components
can be configured:
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Transceiver
In this field select the name of the Com-Server to which the
EnOcean components should be assigned.

ID number
The ID number is the unique number assigned to an EnOcean
module at the factory as an 8-place hexadecimal number. On
some units it is printed legibly, but on others unfortunately not.
Enter - if known - the ID number for the sensor which you want
to assign to the Com-Server. If there is no such information
available, you can use the option Listen to RF traffic to pick up
the ID of a data telegram sent by the sensor and enter it in the
ID number field. This field is not relevant for assigning virtual
signals to the EnOcean Com-Server.

Listen to radio traffic:
If the ID number cannot be obtained by any other means,
activate this function and have the corresponding EnOcean
device send a few RF telegrams. Once you are sure you have
identified the device, you can copy its ID number from the list
by clicking on it with the mouse.
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OPC device name
All OPC variables for a device begin with a common name
component which you can specify here. The OPC device name
can be automatically generated or assigned here. In the former
case the name has the format  EnO[n] where n= 1..65536

Module type
Select whether the component is an analog sensor based on
the EnOcean STM100 module, an RF sensor based on EnOcean
type PTM100 or PTM200, or whether an RF actuator is to be
controlled with a virtual signal.

Analog sensor
To link an analog sensor with the EnOcean Com-Server you
must enter the sensor ID or copy the ID from the RF traffic as
well as assign (selected or automatically generated) an OPC
name for the sensor.

In the case of the three A/D converter channels of the ST100
analog sensor module you can also scale the obtained values.
The STM 100 analog sensor module is not a finished end
product, but rather is installed by various manufacturers into
their own sensor applications. It itself contains no sensors and
in its RF telegrams only provides raw 8-bit A/D converter
values. According to which law these correspond to a physical
variable (e.g. temperature) depends on the connected
measuring circuit and can normally be looked up in the data
sheet for the sensor application.

As a specific example we have provided scaling parameters for
the room temperature sensor SR04 made by Thermokon Sen-
sortechnik GmbH („Thermokon“ button).
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PTM100 or PTM200 switch
Linking one of the above named switch types to the EnOcean
Com-Server simply requires that you enter the sensor ID or take
it from radio traffic, and assign a freely or automatically
generated OPC name for the sensor.

Virtual module
With „virtual signals“ you can control RF actuators through the
EnOcean Com-Server. For this puspose the Com-Server simulates
the button press of a PT100 radio switch and generates radio
telegrams having the contents of such a component.
Generation of a virtual send signal requires only entry of an ID
offset and a freely or automatically generated OPC name. The
ID offset is added to the base ID of the EnOcean transceiver
module to form an overall ID which is integrated in the
respective EnOcean Com-Server.

Concluding the installation
Once all the components have been entered, you should store
the complete device list in a configuration file using File > Save
as .... Starting the OPC server with the correct configuration file
is made much easier if you specify the path and name of the
stored file under OPC-Server > Options > Default configuration
file on startup.
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OPC server start
If when the OPC server was installed you selected Standard
configuration file at program start, opening an OPC client
immediately loads the OPC server and starts it in the correct
configuration.

If no configuration file was specified, starting the OPC client
does load the OPC server but does not start it due to lack of an
available configuration. In this case you must explicitly load the
configuration file using File > Open and start the OPC server
using OPC-Server > Start/Stop. The started OPC server can be
deactivated through the same menu path.

If you start the OPC server by double clicking on the configura-
tion file, you must also likewise start it using OPC-Server >
Start/Stop.

To prevent errors we therefore strongly urge you to configure
the OPC server such that a configuration file is automatically
loaded at program start.
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Diagnostic function of the OPC server

The OPC server makes it possible to show and affect the status
of the connected EnOcean components without being
connected to an OPC client. While the OPC server is running
you only have to double click on an EnOcean device to open
one of the following windows.

Digital sensors:
PTM100 type RF sensors the actuated sensor is indicated by
small check marks:

Analog sensors:
For PTM100 type analog sensors the measured values on the
three analog channels are output both as a numerical value and
as a bar graph. In addition the status of the digital inputs is
indicated by small check marks:
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Virtual modules:
In the following window you can drive radio actuators using
radio telegrams which simulate a PTM100 sensor.

The window represents the switching state possibilities of such
an radio sensor and also allwos you to determine the button-
press duration in increments of 100, 500 and 2000 ms.

Learning actuators
The ability to generate data telegrams directly from the OPC
server is quite useful for learning actuators. This does not
require using an OPC client for generating data telegrams.

This learning procedure is not different from the standard
EnOcean learning procedure:

EnOcean Com-Server and receiver are brought to within a few
meters of each other. Then learning mode on the receiver is
activated as described in the manual for the receiver. To assign
the EnOcean Com-Server and receiver, exactly one (!!) data
telegram is sent to the latter from the window shown above.

Attention: another data telegram with the same infor-
mation resets the entry in the assign list of the
actuator.

This concludes the procedure and the actuator can now be dri-
ven through the EnOcean Com-Server.

1
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OPC variables for EnOcean RF modules

The OPC server provides the OPC variables described below for
the various EnOcean components. Device names EnO1, EnO2,
EnO3 should be considered examples only.

OPC-Variables for analog sensors
EnO1.A - EnO1.D (Boolean variable, read-only access):
State of the binary inputs.

Note: These signals are inverted with respect to the binary
content of the data telegrams. But since most buttons are
wired as pull-down to ground, this in fact means that a „1“
corresponds exactly to a pressed button and a „0“ to a released
button, just as one would expect.

EnO1.N.A - EnO1.N.D (Integer variable, Read/write access):
Event counters which are always integrated when the associa-
ted binary input A - D changes from 1 to 0. Any desired values
count be written in, but the most logical write process would
be simply resetting to 0.

EnO1.S.1 - EnO1.S.3 (Integer- or real variable, read-only
access): Analog sensor measured values. If no scaling is used,
these are whole-number values between 0 and 255. Depending
on the configuration these variables can also however be
floating decimal numbers with a concrete meaning and
represent a temperature value in degrees Celsius, for example.

OPC variable for button modules
EnO2.0.A - EnO2.0.D (Boolean variable, read-only access):
Status „pressed/released“ of the lower halves of the rocker
switches A - D (identified on the housing with „0“).

EnO2.1.A - EnO2.1.D (Boolean variable, read-only access):
Status „pressed/released“ of the upper halves of the rocker
switches A - D (identified on the housing with „1“).

EnO2.A - EnO2.D (Boolean variable, read-only access):
Logical state of the rocker switches A - D: 0 or 1 depending on
whether the lower or upper half of the rocker switch was last
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depressed. This information is inferred indirectly by the OPC
server from the sensor messages and is therefore not available
until after at least one button press has been registered.

OPC variable for virtual modules
EnO3.0.A - EnO3.0.D (Integer variable, Read/write access):
Assigning a value which is not 0 corresponds to pressing the
lower half of one of the rocket switches A - D.

The value is counted down at ten increments per second. As
soon as it reaches 0, the button press is ended. Setting the
variable to 20 then would result in a 2 second long pulse.

EnO3.1.A - EnO3.1.D (Integer variable, Read/write access):
Assigning a value which is not 0 corresponds to pressing the
upper half of one of the rocket switches A - D.

The value is counted down at ten increments per second. As
soon as it reaches 0, the button press is ended. Setting the
variable to 20 then would result in a 2 second long pulse.
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The Windows COM Port Redirector

In addition to being able to access the EnOcean Com-Server
data through the OPC port, the Windows Com-Port Redirector
gives you direct access to the data which the EnOcean RF
module integrated into the Com-Server provides. The COM
ports provide the raw data from the RF module without any
pre-processing however, so that interpretation of the EnOcean
protocol has to be handled by the respective application.

Detailed information about the EnOcean protocol can be found
in the manual for the EnOcean Transceiver Module TCM120,
which EnOcean makes avai lable on its Web site at
www.EnOcean.com.

When you use the COM-Port Redirector for Windows 9x, NT,
2000 and XP, virtual COM ports are installed in the respective
system. These behave just like normal local ports with respect
to a serial application, but they represent the RF module port of
the EnOcean Com-Server located in the network.

Use of the COM-Port Redirector in conjunction with EnOcean
Com-Servers is free and not subject to any licensing.

Where to I obtain a COM-Port Redirector?
You can find the latest version of the COM-Port Redirector as
well as additional tools, application descriptions and FAQs at
our Web site:

http://www.wut.de

From there use the menu tree on the left side of the page. The
path Products & Downloads r Com-Server takes you to the
menu branch containing a direct link to the COM-Port
Redirector.

Settings on the EnOcean Com-Server
All the EnOcean Com-Server needs to operate with the COM-
Port Redirector are the 3 network-specific parameters IP address,
subnet mask and gateway address. The serial transmission
parameters such as baud rate are determined by the serial
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application and sent by the COM-Port Redirector over the net-
work to the EnOcean Com-Server.

Here it is absolutely necessary to set 9600 baud, 8 data bits, 1
stop bit, no parity and no handshake.

Installating and configuring the COM-Port Redirector
Installation and configuration of the COM-Port Redirector are
described in the respective online help.
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Firmware update for the EnOcean Com-Server

The operating software of the EnOcean Com-Server is subject
to continuous enhancement. The following section describes
how to perform an upload of the firmware to the EnOcean
Com-Server.

Where can I get the current firmware?

The most current firmware including the available update tools
and a revision history is published on our Web site at:

http://www.wut.de

From the window Insider search by article no. below the menu
tree enter the article number of the EnOcean Com-Server and
set the selection window below it to Firmware. Click on Go to
get to the must current firmware for the EnOcean Com-Server.

If you do not know the article number, you can find it oin the
sticker located on the narrow side of the housing, which also
indicates the Ethernet address.

Type no.

58xxx [description]

EN=00c03d004a05

OK xxxxxx

Description, e.g. TB-number
for special versions
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Firmware update

You must have a PC running under Windows 9x/NT/2000/XP
with a network connection and activated TCP/IP stack. For the
update process you will need WuTility and the update file
(*.uhd), which as described above can be downloaded from the
W&T Web site at http://www.wut.de.

No special preparation of the EnOcean Com-Server is
necessary for the firmware update. Simply ensure that all data,
controller and configuration connections are closed.

Click on the Firmware button to go to the next window where
you can select the desired update file. After confirming your
entry with Continue, the update procedure of the EnOcean
Com-Server begins.

Never intentionally interrupt the update process by
pulling the network plug or pressing the Reset key.
After an incomplete update the EnOcean Com-Server
will not be functional.
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Hardware reset to factory defaults

In addition to using WuTility or the telnet configuration (Port
1111) to reset the EnOcean Com-Server to its factory defaults,
you can also perform a hardware reset: All models have two
jumpers located directly next to each other on the circuit
board. For normal operation these must be open. To restore the
factory defaults, proceed as follows:

� Turn off or disconnect power from the EnOcean Com-Server
and open the housing. Carefully pulling on the threaded-in
antenna plug while pressing on the long sides of the
housing allows the board to be pulled out of the housing.

� Close both jumpers and restore power. An internal self-test
lasting approx. 20 seconds will follow.

� After approx. 20 seconds the self-test will finish and the
factory default settings are restored.

� Turn off power to the EnOcean Com-Server, open both
jumpers and close up the housing.

1Resetting the non-volatile memory will result in loss of
all the settings which are different from the default

values, including the IP address. The setting profile for the
factory defaults can if necessary be replaced with a custom
profile. In this case the custom settings are activated after the
reset.
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Technical Data

Network interface: 10/100BT autosensing

RF interface: EnOcean Transceiver-Interface
with SMA terminal for antenna

Frequency: 868.3 MHz
Transmitting power: 10mW
Antenna External, freely positionable

antenna
Range: typ. 300m outdoors

typ. 30m indoors
Number of transmitters: Any number of transmitters can be

received
Number of receivers: max. 128 receiver groups per

EnOcean Com-Server

Galvanic isolation: min. 500 Volt between network and
supply

Software interfaces: OPC-Server
Windows-COM-Port Redirector
TCP and UDP sockets,
Client and server on request

Supply voltage: DC: 12V (-10%) .. 48V (+10%)
AC: 9Veff (-10%) .. 30Veff (+10%)

Current draw: typ. 70mA @24V DC

Ambient temperature: Storage: -40..+70°C
Operating:
Non-rowed installation: 0..+60°C
Rowed installation: 0..+50°C

Housing: Plastic compact housing,
105x75x22mm

Weight: approx. 450 g

Scope of delivery: EnOcean Com-Server
External antenna with 2m cable
Plug-in power supply for office use
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Declaration of Conformity
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